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Introduction 

What Is Business Card Reader ?
Business Card Reader, or BCR, is a new kind of optical character recognition (OCR) 
application designed exclusively for business card. With its high speed and accuracy, BCR is 
the perfect program for busy sales and marketing executives as well as administrators.
This new timesaving application is easy to learn and pleasure to use. It will save valuable 
time you would otherwise spend manually entering business contact information into 
database. In just a few easy steps, BCRs friendly interface lets you scan and discard your 
accumulated business cards, then store the scanned images, along with important contact 
information, as database entries.
BCR databases, or card bases, can hold up to 32,000 entries (depend on your system 
capabilities) than you can sort by any field. BCR provides you with a text record along with a 
perfect image of the card itself, including logo, to store.
Superior Image Quality
Unlike other optical character recognition software, BCR incorporates its own unique 
scanning techniques to give you exceptionally high quality images.
Brightness is the single most important factor affecting the accuracy of the text recognition 
for any OCR application. With most programs, you need to adjust the brightness threshold 
for each document scanned. When you scan a business card that has gray as well as black 
lettering, some image quality will be lost with manual threshold setting.
But BCR uses adaptive threshold scanning, continuously adjusting for brightness while a 
document is being scanned. This means that when you scan documents with different levels 
of brightness, everything- no matter how light or dark it is - comes out crisp and legible. The 
result is sharper image and fewer recognition errors.
Other Features
BCR recognizes any    business card layout, vertical as well as horizontal. It also recognize all 
commonly used fonts, even if they are mixed within a block of text.
You can scan single or multiple business cards at a time. Text recognition and entry are 
automatic. After scanning, BCR separates image into graphics and text, recognizes relevant 
information for database entry, and places it into the appropriate text fields. Within seconds,
business cards are entered into database format. BCRs simple built-in editor lets you quickly 
edit entries immediately after scanning or later, long after they have been stored.
You will also appreciate BCRs Export and Linking features for sharing BCR databases with 
other programs.
BCR operates under Windows 3.1. If you are comfortable in the Windows environment, you 
will find this application very user friendly.
We would like to thank you for purchasing BCR. We are confident that you will enjoy our 
economical and timesaving package.



The Business Card Reader Interface 

Main Menu
Image Window
Command Buttons
Data Fields
Status Line
Cursors



Main Menu 
The main menu at the top of the screen offers five separate items:    File, Edit, Mode, Link, 
Settings and, to the far right, Help.    Each of these is manipulated in standard Windows 
fashion. 
File

New Base
Open Base
Export All
Normalize Base
Normalize Card
Compress Base
Append Base
Print Deck
Exit

Edit
Cut
Copy
Paste

Mode
Scan
Deck
Edit

Link
Link
Unlink
Update
Auto Update

Settings
Input
Scanner
Browse
Font
Normalize
Date/Place



Image Window 

Here, in the upper left quadrant of the screen, is where the scanned business card images 
appear.    The Image Window is used for viewing card images in all modes.    You cannot alter 
or edit these graphic images in any way, although you can copy text from the card image to 
the data fields below right after scanning.



Command Buttons 

To the right of the Image Window are twelve command buttons which you operate by 
clicking once with the cursor or by keying in a combination of the <Ctrl> button plus the 
character underlined on the command button.
The particular command buttons active at any given time will depend upon which screen 
mode youre operating in.

Command Buttons in Scan Mode
Command Buttons in Deck Mode
Command Buttons in Deck Mode



Data Fields

These occupy the bottom half of the screen below the Image Window and command buttons.
The entry contains the following fields:

Company Address
Name City
Title State
Phone Zip
Fax E-mail
Telex Notes 
Date Place

BCR automatically fills these fields in with the appropriate data after a new business card is 
scanned.    You will edit your entries in the data fields.



Status Line 

Status Line at the bottom of the screen displays the programs activity status, the field by 
which card base entries are sorted, the current screen mode and, at the far right (0:0), the 
order of the entry in the open card base.    For example, Deck 3:43 would indicate that the 
Image Window now displays the third entry in a card base deck containing a total of 43 
entries.



Cursors 

The cursor assumes various forms in BCR, depending on where its placed on the screen and 
the operation you are executing.

 a pointer for clicking on command buttons
      a text cursor for editing text within the data fields
 a hand for dragging selected text



Screen Modes 

The BCR screen operates in three basic modes: Scan, Deck and Edit. Each of these modes 
looks similar to the others, but the operations you can perform are different in each.    Note 
that no particular mode is active when you open BCR for the first time.

Scan Mode
Command Buttons in Scan Mode

Deck Mode
Command Buttons in Deck Mode

Edit Mode
Command Buttons in Deck Mode



Scan Mode 

BCRs Scan mode is for entering new business cards in an open card base.    When you open 
the BCR program for the first time, the Scan Mode is active.
Before scanning, you must enter specifications for Input and Scanner options in the 
Settings menu.
When scanning is complete, the card image appears in the Image Window and BCR proceeds
with recognition, separating text from graphics and creating groups of text fragments.    BCR 
then aligns the card image and places the text groupings it created into the data fields.    The
text fragments will be outlined on the card image.
Command Buttons in Scan Mode



Command Buttons in Scan Mode 

Start Scan
Store
Type Card
Forget All
ForgetIDHELP_FORGET
Addr Edit



Start Scan 

The Start Scan command button is active when you first start the program and after youve 
stored a scanned entry.    After entering Input and Scanner settings place your card(s) at 
the proper orientation into the scanner and click Start Scan (or type in <Ctrl> + S) to 
initiate scanning. 

Single Card Scanning
Multiple Card Scanning



Store 

When you are satisfied with all the information in a newly scanned entry, click Store to save
it in the open card base.    The saved entry disappears from the screen.    If you have scanned
multiple cards at one time, the next unstored entry appears on screen for you to change 
and/or store.    If you      have scanned just a single card, storing clears the screen entirely in 
preparation for the next scan.



Type Card 

Type Card lets you enter information directly into the data fields without scanning a card.    
This mode is useful either when you have business cards with extremely poor print quality or
you do not have business card at all.



Forget All 

Click Forget All to delete several cards at one time after multiple card scanning.    Forget 
All deletes the current image as well as any scanned images that havent been inspected 
and saved.    After you select Forget All, you will be asked to confirm that you want to 
delete the unsaved images.    Click Yes to go ahead and delete the unstored cards or No to 
terminate the deletion altogether.



Forget 

Forget deletes the single, unsaved card entry currently active in the Image Window.    
Before you select Forget, make certain that you want the entry deleted.    You will not have 
an opportunity to undo the deletion.



Addr Edit 

Occasionally BCR divides and distributes components of a business card address incorrectly.  
In this case you can edit the data fields manually, but, unfortunately, BCRs Drag-and-Drop 
feature wont help you; if you redraw a box around a portion of the address, BCR will 
probably repeat its error.    Alternatively, you can press the Addr Edit button (or double-click
on a data field) to switch to the address editing mode.  A different set of data fields appears 
at the bottom of the main screen, as illustrated below.
BCR presents the entire address, as well as the contents of its four subfields, as text strings.  
Now you can highlight portions of the entire address or of a specific subfield (using left 
mouse button).    After highlighting a portion of text, drag it (using right mouse button) and 
drop it into a new destination field.    The previous contents of the destination field will be 
replaced with new data.
You can drop portions of one address to subfields of another address field.    When you have 
made all necessary changes, click on Addr Edit (or double-click on a data field) again to 
return the standard data fields to the main screen.



Deck Mode 

The Deck screen is primarily for searching for and retrieving entries.    Only the card images 
are visible on screen.    Because the data fields in Deck mode are used to create filters for 
selecting subsets of a card base, initially they are empty.
The Deck mode provides several methods for creating card base filters.    One is a Field 
Lists method of entry retrieval.    The advantage of this method is that you wont need to 
remember the exact spelling of a name or company to conduct a search.
To see how Field Lists works, make sure you are in Deck mode, and double-click on the 
name of a data field like Company.    A scrolling list of all the companies in your card base will
appear, arranged alphabetically.
Field Lists are always indexed independent of the sort field you assign for the Browse 
setting.    In other words, if you double-click on Company, the list that appears will be 
arranged according to company name, even if you have designated Address as the Browse 
setting.
Next, double-click the cursor on the name of a company whose entries youd like to inspect 
and/or change.    (You can also click once on the entry and then click OK.)    The company list 
disappears and the cards for the selected company appear in the Image Window.
If more than one card is found for the company, the screen remains in Deck mode.    If only 
one card was found for the selected company, the screen goes directly into the Edit mode 
with the data fields for that entry active and ready to edit.    Notice that the number of 
entries found for the company selected is shown on the Status Line.
If you click once on an entry from the company list, but change your mind, just click Cancel 
to return to a view of the last card selected.
Another way to create filters for selecting entries in Deck mode is to type key text 
characters into specific fields and click on the Find command button.    If, for example, you 
wanted to search for all companies within the (415) area code, type 415 into the Phone 
field and click Find.    The cards for all companies with phone numbers having that area code
will appear in the Image Screen.
Deck mode also lets you use the right mouse button to look through cards sequentially.    Just
click once on the top card in the deck, and the next entry will appear.    Click on the 
previously viewed card (seen in the background) to bring it to the front for viewing.    You can
even advance (or go back) several entries by reaching down deeper in the deck with the 
pointer and clicking the right mouse button.
Command Buttons in Deck Mode



Command Buttons in Deck Mode 

Find 
Clear
Top and Bottom
Next and Previous
Browse
All
Export



Clear 
Clicking Clear automatically clears all fields and the Image Window in preparation for a card
search using Find.    Clear does not delete entries, so dont panic when all the fields empty.



Find 
To locate a specific entry or a subset of the card base, use the Find button.    This button is 
active in both Deck and Edit modes.
Suppose you want to look for all of your prospective clients from Cognitive Technology 
Corporation.    Place the cursor in the Company data field and type in Cognitive.    Now click 
the Find command button or press <Enter>.    BCR will begin searching.    When its finished,
the number of cards found for Cognitive Technology will be displayed at the left end of the 
Status Line.
If no cards are found, the Status Line will read 0 card(s) found.    Click on the Clear button 
(or type <Ctrl> + C) to clear the data fields, and enter another search key to try to find the 
card again.    If multiple cards are found, the screen will stay in Deck Mode, with the cards 
representing the found data subset stacked in the Image Window.    If only one matching 
record is found in the course of the search, the screen will go directly into Edit mode.
The Find button will conduct a search based on any data field and any key word within that 
data field.



Top and Bottom 
Click once on Top (<Ctrl> + T) to bring up the first card in the deck.    Click once on 
Bottom (<Ctrl> + B) to bring up the last card.



Next and Previous 

These command buttons offer another simple way of looking through cards in the deck 
sequentially.    Click on Next (<Ctrl> + N) to view the next card.    Choose Previous 
(<Ctrl> + P) to return to the last card you viewed.



Browse 

Use the Browse button to look over your entire card base, or to select an entry for closer 
inspection and editing.    Click on the Browse command button (or type <Ctrl> + R) to 
invoke a window containing a scrolling List of Entries in the card base.    The specific fields 
displayed and the order in which entries are listed will depend upon how you set the order 
under Browse in the Settings menu.    The field by which the card base is sorted is shown 
in the Status     Line  , to the left of the mode indicator.
There are two ways to select an entry to edit from the list.    Either double-click on the entry, 
or click on it once and then click OK.    In either case, the screen instantly moves to Edit 
mode, with the selected entry displayed in the Image Window.    With the second method, its 
possible to cancel your selection.    If you decide to select Cancel, the screen returns to 
display the last card shown.



All 

Click on All (or enter <Ctrl> + A) to bring the entire card base deck into view in Deck 
Mode.    If you have just retrieved several entries through Find in the Deck mode, click All 
to return to the full deck.    If you click All while in the Edit mode, the screen will transfer 
immediately to Deck.



Export 

The Export command button is for exporting a subset of the card base to another program.  
Use it to transfer data from just one entry, or from several found through a search.    If you 
find seven cards for a specific company in your card base, you can selectively export them 
while theyre stacked in the Image Screen.
The Cards Export window appears as soon as you click on Export (or <Ctrl> + E).    This 
window is identical to the one that comes up when you use the Export All option from the 
File menu to export an entire database.    Specify the name of the file to which youre 
exporting the entries, as well as the drive and directory containing that file, and click OK.
To move from the Deck screen to the Edit screen, either select Edit from the Mode menu 
(<Alt> + M, then E), or double-click on a card in the Image Window.



Edit Mode 

BCRs Edit mode lets you edit stored card base entries.    Unlike the Scan Mode, Edit mode 
doesnt let you extract information from the card image itself.    Instead, you work only within 
the data fields.
To get into the Edit screen mode from Deck Mode, select Edit from the Mode menu 
(<Alt> + M, then E), or double-click on the card displayed in the Image Window.    To get to 
Edit from the Scan Mode, you can only select Edit from the Mode menu.
While in Edit mode, you can perform almost all the operations that you can in Deck.    (The 
exception to this is use of the right mouse button to leaf through sequential entries.    The 
command buttons Next and Previous, however, accomplish the same thing.)
Edit mode has a Drag-and-Drop feature for moving text from one field to the next.    If, for 
instance, you notice that the fax number is in the Phone field, just click and hold on the 
number using the right mouse button.    The text cursor becomes a hand.    Drag the number 
into the Fax field and release the mouse button.    The number now appears in the proper 
field.
Delete text by dragging it from its field over to the Delete button.    When you do this, the 
hand cursor assumes the form of a trash can, indicating that youre about to throw the text 
away.
Once deleted, this information cannot be retrieved.    You can always go to the next or 
previous entry, or return to Deck Mode without saving the changed entry.    In this case, the 
information you threw away will return to the field it was in originally.
You can also edit your entries in the same way you edit using conventional word processing 
applications.    Simply select the text you wish to replace with the text cursor and type over 
it, or insert new text into existing text.
In addition to its editing features, the Edit mode lets you Dial out on your modem.
In Edit as well as in Scan, the Edit pull-down menu is activated.    This a conventional edit 
menu that includes Cut, Copy and Paste options that become active when you highlight 
text to edit.

Command Buttons in Deck Mode
Command Buttons in Edit Mode



Command Buttons in Edit Mode 

The Edit mode has three command buttons in addition to those found in Deck Mode. These
are Dial, Store and Delete
Command Buttons in Deck Mode



Dial
The Dial command button lets you dial the phone number in the current entry through a 
modem line.    Once you click Dial, the window shown next comes up.
The first number from the Phone data field is highlighted in the Phone to dial box.    You 
can either accept the number as shown, manually edit it, or select a replacement number 
from the Choice of numbers list below it.
The Dial prefix field at the bottom left of Dial window lets you specify any special prefix 
you need to dial (e.g., a 9 to obtain an outside line from within your office).    
Enter your own area code in the box labeled Local area code.    BCR compares this    area 
code with the one in the Phone to dial box.    If they are the same, BCR recognizes that you 
are making a local call and omits the area code from the dialing sequence.    If they differ, 
the area code will be dialed along with the rest of the number.
Next to Modem on, select the modem through which youll be dialing.    Now click OK to 
initiate dialing, or Cancel to abort the operation.



Store (EDIT MODE) 

Click once on Store (or type in <Crtl> + S) to store an entry when you want to save any 
changes you have made.    Store saves one entry at a time in both Edit and Scan Modes.



Delete 

With Delete you can either delete an entire entry or just a selected field.    These operations 
are carried out in quite distinct ways.
To delete an entire entry, press Delete any time you are in the Edit screen.    The entry will 
be lost no matter what field you have selected and regardless of where the cursor was 
previously placed.    Before it deletes anything, a window appears asking you to confirm the 
deletion.
To delete a single field of text only, select the text by placing the cursor just to the left of its 
data field, then drag that selection over to the Delete button and release.    The field will 
empty.    You can leave it blank or enter new data manually.    If you delete a single field of 
text, but change your mind, you can always go back to the Deck Mode without saving the 
changes.    The fields in that entry will revert to their previous, unedited values.



THE BCR MAIN MENU
Most of the main menu items at the top of the BCR screen are available and active in all 
three screen modes.    The only exception is Edit, which can only be activated in Edit and 
Scan Modes. Each menu item is described in detail below.



The File Pull-Down Menu 

To see the File pull-down menu, click once on File or key in <Alt> + F.
New Base
Open Base
Closing Base
Export All
Normalize Base
Normalize Card
Compress Base
Append Base
Print Deck
Exit



New Base 
The New Base option in Files pull-down menu is active in all three screen modes.    You can 
create a new card base from any screen mode, but after you have created one in the Deck 
or Edit screen, BCR will transfer immediately into Scan Mode in preparation for scanning 
the first entry in the new card base.
When you select New Base with your cursor (or type <Alt> + F, then N), the Create 
Cards Base window appears.    From the Directories and Drives lists, select a directory 
and drive for storing your new card base.
In the File Name field, replace the asterisk to the left of .cdb with a name containing up to 
eight characters.    For our purposes, well use Prospect.    Now click OK.    The BCR main 
screen appears with the name of the new card base, Prospect.cdb, displayed to the right of 
BCR in the heading.
You neednt make changes in the Save File as Type box at the bottom left of the window.    
The default setting Cards Base is the form card base files remain in unless you Export 
them to another program.
The main screen now transfers to Scan Mode, in preparation for scanning and storing your 
first card entry.



Open Base 
Click on Open Base in the File menu (<Alt> + F, then O) to call up a window with the 
heading Select Cards Base.    To open an existing card base, either type its name into the 
File Name field and click OK, or double-click on the file name in scrolling list below the File 
Name field.
Other fields allow you to select a directory or drive other than the one you are in.    The List 
of Files Type will always display (*.cdb) when you create a new card base or open an 
existing one.



Closing a Card Base 
BCR has no separate command for closing a card base.    When a card base is open and you 
go to the File menu to either open an existing base or create a new one, the file currently 
open automatically closes.    
If you have made changes to an entry in the open card base without saving it, a BCR: 
Warning box comes up, asking if you want to save your changes.    Click Yes to save your 
edited entry before opening another card base, No to lose your changes and open another 
base, or Cancel to stay in the current card base.



Export All 

You can export BCR entries to Lotus Organizer as well as any applications that accept 
the.dbf file type, including Excel.
If you want the entire card base currently open to be copied to another program, select the 
Export All option in the File menu (<Alt> +F, then E).    This will invoke the Cards Export 
window.
Type the name of the file into the File Name text box, or double-click on a file name in the 
scrolling list beneath the text box.    Now go into the recipient application to import the 
exported BCR data.
Export All is really only active in the Deck screen mode.    If you select it while in the Edit 
mode, the screen will instantly revert to Deck Mode.



Normalize Base 
Use the Normalize Base option to establish consistent style formats for data fields. In a 
normalized card base, all data fields are converted to some standard format, depending on 
the data field semantic. 
Before normalizing a card base, you must choose normalizing types for all data fields using 
the Normalize option in the Settings menu (see description later in this chapter). 



Normalize Card 
Select Normalize Card to normalize data fields for the current card only.    To save the 
normalized card (replacing the non-normalized card base entry), click either Next or 
Previous.    Youll be asked to confirm replacement of the existing card base entry.



Compress Base 
While you are using business card base you can edit several cards and Store them, you can 
delete some cards, normalize all base and so on. Each of this operations can leave unused 
disk space within a .cdb file as well as within a .img file. To optimize the use of hard disk 
space you can compress business cards base.
Choosing Compress base menu item starts the procedure of the current cards base. You 
can interrupt this process at any time by clicking on Cancel button of the progress monitor.



Append Base 
Use Append base to add cards from some other business cards base to the one which is 
open now. To do this chose Append Base menu item. You will be asked for name of a cards 
base to append to current base.
You can select name of a base to append and click on OK button to start process of merging 
or click Cancel button to reject go futher.
If you selected a base to append, the progress monitor will appear on the screen.
You can stop merging at any time by clicking    Cancel button of the progress monitor. Your 
current base will remain unchanged.



Print Deck 
When you select Print Deck, dialog box appears, prompting you to indicate the number of 
copies, print quality and some other details. When youve completes all the settings, click 
OK. The images of all cards in the currently selected deck will be printed out.



Exit 
To exit BCR, you can either select Exit from the File menu, or key in <Alt> + F, then X.



The Edit Pull-Down Menu 
The Edit menu becomes active only in the Edit and Scan screen modes after you select a 
block of text to change.    It is not active in Deck Mode.    The three options in its pull-down 
menu - Cut, Copy and Paste -    all operate in standard Windows fashion.
With your cursor, select some text in one of your data fields.    Select Edit in the main menu 
and choose Cut from the pull-down menu (or just key in <Shift> + Delete).    Click you 
cursor anywhere in a different data field, and then select Paste (<Ctrl> + Ins) from the 
Edit menu.    The text you cut from the first data field will be inserted where you placed your
cursor in the second field.    The Copy option 
(<Shift> + Ins) works in the same way.



The Mode Pull-Down Menu 

The Mode menu lets you switch easily between BCRs Scan, Deck and Edit screen modes.    
The menu options can be activated by selecting them with the cursor or by keying in <Alt> 
+ M followed by S for Scan, D for Deck or E for Edit.    A check mark appears to the left of 
the mode you select.

Scan Mode
Deck Mode
Edit Mode



The Link Pull-Down Menu 

Access the pull-down menu for Link either by clicking once on Link or by keying in <Alt> +
L.    BCRs special linking feature is designed specifically for use with Lotus Organizer.    It 
lets you establish a data exchange link between your BCR and Organizer files so that 
changes and additions to a BCR card base file will automatically be reflected in the linked 
Organizer file.

Link and Unlink Base
Update and Auto Update



Link and Unlink Base 

Choose Link Base from the Link menu to connect your current card base with a Lotus 
Organizer address database.    A window with the heading Select Lotus Organizer File to
Link appears.    Specify the Organizer file to which you want your current card base linked by
typing its name in place of the asterisk in the File Name text box.    Alternatively, select an
.org file by double-clicking its name in the scrolling list beneath the File Name text box.    
The lists for Directories and Drives let you specify another drive and/or directory.
Please note that linking to an Organizer file does not open that file.    In fact, BCR cannot 
transfer data to an open Organizer file.    If you try to write to an open Organizer file through 
the BCR link (e.g., when you perform an operation like Store, which would otherwise update 
the Organizer), an error message will advise you that data transfer is impossible.    To make 
the link successful, youll first have to go into Lotus and close the linked Organizer file.
Once youve chosen an Organizer file, its name appears in the heading next to the name of 
the BCR file to which its linked.    A window with the heading Export into Lotus Organizer 
appears.    The window prompts you to indicate whether you want all the entries in the BCR 
home file exported to the linked Organizer file.    Click Yes if you want all entries from the 
open card base exported.    If you click No, only new changes and additions you make to the 
card base will be reflected in the Organizer file.



Update and Auto Update 

The Update and Auto Update options in the Link menu determine how data will be 
transferred.    Select Auto Update if you want all the changes and additions you make to be 
reflected instantaneously in your Organizer file.    A check mark appears to the left of the 
option to indicate that it is selected.
If, for some reason, you want to make a number of changes in your BCR card base, but dont 
want these changes to be reflected yet in the linked Organizer file, you can delay the data 
exchange.    First, make all the changes and additions to the BCR file.    When youre finished 
and ready to transfer the data to the Lotus Organizer, select Update.    This will then 
update the linked Organizer file, making all the changes to entries corresponding to edited 
or new card base entries since the last data transfer occurred.



The Settings Pull-Down Menu 

Click once on Settings or key in <Alt> + S to access its pull-down menu.

Input
Setting Scanner
Setting Browse
Font
Setting Normalize
Set Date/Place



Input 

Select the Input option from the Settings pull-down menu to specify the dimensions of the 
area you want to scan.    The Page Layout window shown below provides separate fields 
into which you type the measurements of the desired area (card or page) to scan.
The default values for single card scanning are Left: 0.00, Top: 0.00, Width: 3.50 and Height: 
2.00.    This corresponds roughly to the dimensions of a standard business card.    Click OK.    
(Be sure that the Multiple Cards box is unchecked.)
For multiple card scanning, the values you enter for page size can be approximate, but 
should at least include the area occupied by the cards placed.    Check the box at the bottom 
of the window to select Multiple Cards and click OK (or Cancel if you wish to quit the 
operation entirely).



Setting Scanner 

Before scanning any business cards in BCR you must select Scanner settings.    Choose 
Scanner from the Settings menu (or type <Alt> + S, then S) to invoke the Scanner 
setup window illustrated below.
From the box labeled Access, choose a scanning systemsISIS, Specific, or TWAIN.    When 
you choose a system, the name of currently selected scanner appears in the Scanner field 
below.    Next, click OK to confirm, click Scanner to make another selection or click Setup to
initiate a setup procedure.
Setup procedure
For a TWAIN scanning system, select either Native or Buffered transfer mode.    You can 
also choose to use the TWAIN-source dialog.    Consult your scanner manual for details.
With an ISIS scanning system, most scanners dont require any setup. Again, consult the 
scanner manual.    If your system is neither TWAIN nor ISIS, select Specific from the Access 
box.
Scanner Selection
For any type system you choose, a box listing all currently available scanners of that type 
appears when you click the Scanner button.    Choose one of these and click Select (or 
Cancel).



Setting Browse 

Choose Browse (<Alt> + S, then B) from the Settings menu to set the order in which you 
will want entries listed and to specify the fields you want included when you use the Browse
command button (described below).    BCR will sort your entries based on any of fourteen 
data fields.
Click once within the circle to the left of the data field by which you want your entries sorted.
The circle darkens to indicate that this is the sort field you chose.    Click OK to initiate the 
sort.    When the operation is completed, the name of the sort field will appear in the 
Status     Line  , just to the left of the screen mode display.    
Check to see if your entries were sorted properly by clicking on the Browse command 
button.    A scrolling list of sorted entries appears on screen.    The sort order will also be 
retained in the cards displayed in the Deck screen.
Two additional parameters for viewing entries can be set in the Select Fields and Key 
Field for Browse window.
Use the boxes to the left the field names to designate the fields you want to include in the 
Browse listing, as well as the order in which you want them listed (from left to right in the 
Browse window).    The illustration above shows the default setting for fields to display.    In 
this example, when you click Browse, all fields will be shown with the name displayed first, 
company second, title third, etc.
To change these settings, click on Reset.    This will clear all of the boxes so that you can 
customize the Browse listing.    
Suppose, for example, that you want to display the name, title, and company for each entry,
and in that sequence.    Click first on the Name box, next on the Title box and, finally, on 
the Company box.    As you select each box, sequential numbers (1, 2 and 3) will appear 
inside of them.    Click on OK.    When you next click Browse, youll see the fields for Name, 
Title and Company displayed from left to right in the window.
You can also change the Browse settings by deselecting the fields that you dont want to 
display.    Just click in the numbered box to the left of the field.    The box will empty (the 
number disappears), indicating that this field will not be included in the listing.    The other 
selected fields will be automatically renumbered, reflecting the absence of the deselected 
field.
To revert to the original default settings, click Reset and then OK.    When you next invoke 
the window for specifying the browse settings, the fields will appear in their default order.
Note that you can also select a key field for a new card base before entering scanned cards 
into it.    The newly scanned cards will be automatically sorted as they are stored.



Font 

Select Font from the Settings menu to call up the Font window.
You can choose from different fonts and point sizes to customize text in the data fields of 
your entries.    When you change settings, the Sample box instantly shows you how text will 
look from now on.    When youre satisfied with the font settings, click OK. 
Do not    bother yourself with choosing Font Style because    BCR always use Bold for field 
names and Regular for fields content.



Setting Normalize 

If you want data in certain fields to conform to specific formats, you can set these by 
selecting Normalize from the Settings menu. The following window will appear:
This window displays the current normalization settings for all fields and lets you choose 
from different formats for each.    Click and hold on a downward-pointing arrow to view a list 
of available formats for a field. Scroll through the list and click the desired entry. Note that 
the option No Normalizing appears in all the lists. You can also switch Normalization off 
by ckecking the box at the top of the window. In this case, all list arrows will be ghosted.



Set Date/Place 

When you click Set Date/Place in the Settings menu, the following window appears.
In the box labeled Date, specify one of three options for the Date field: leave it empty 
(Empty Date), enter the Current Date or enter a specific date (to be typed into the Set 
Date> field).
In the text box below Place, enter any text that you want to go in the Place field. For 
example, if you have a stack of cards from a recent seminar, you could use this feature to 
create a default Place setting for those new cards. Make sure that you reset or empty the 
Place text box after entering your new cards. Otherwise, its contents will go into the Place 
field for all subsequent card entries.
Date and Place fields can be filled for each card either automatically, when the card is first 
added to the card base, or every time the card data are stored. Choose either mode of entry 
in the box at the bottom of the window.    Click the circle next to Only for new card to fill in 
Date and Place fields automatically only once, when the card is first entered.    Click next to 
On every Store to update both fields each time a card is changed and saved.



Creating A New Card Base 

Suppose you have just exhibited your companys new product at a trade show and have 
collected a large number of business cards which represent sales leads youll have to follow 
up on.
Go to the main menu and click once on File and once again on New Base (or press <Alt> 
+ F, then N).
The Create Card Base window shown here appears.
From the Directories and Drives lists, select a directory and drive for storing your new card
base.
In the File Name field, replace the asterisk to the left of .cdb with a name containing up to 
eight characters.    For our purposes, well use Prospect.    Now click OK.    The BCR main 
screen appears with the name of the new card base, Prospect.cdb, displayed to the right of 
BCR in the heading.
You neednt make changes in the Save File as Type box at the bottom left of the window.    
The default setting Cards Base (*.cdb) is the form card base files remain in unless you 
Export them to another program.
The main screen now transfers to Scan Mode, in preparation for scanning and storing your 
first card entry.    Before you scan, however, youll need to set a few scanning parameters. 
This procedure is described in the Settings menu section of Chapter 2.



Single Card Scanning 

Lets assume for now that you want to scan cards one at a time.    Move your cursor to the 
Settings menu and choose Input    (or enter <Alt> + S, then I).    This will call up the Page
Layout window
Under Page/Card size, key in the dimensions of the card youll be scanning.    Enter the 
appropriate values, expressed in inches, in the dialog boxes labeled Left (left margin), Top 
(top margin), Width and Height.    The default values are Left: 0.00, Top: 0.00, Width: 3.50 
and Height: 2.00, or roughly the size of a standard business card.    Click OK (Be sure that 
the Multiple Cards box is unchecked.)
Please note that Input and Scanner values can be set from any screen mode.    The order in
which you set these is not important.
Now that you have opened a card base file, the Start Scan command button is active in the
Scan screen mode. 
To proceed with the scan, feed a card into your scanner as per the manufacturers 
instructions.    (Although BCR can correct for slightly misfed cards, try to properly align them 
to ensure that you get the best possible image.)    Next, click once on the Start Scan button 
(or enter <Ctrl> + S).    As scanning begins, a window appears to tell you that scanning is in
process.    You can watch the left side of the Status Line to follow the stages of scanning 
and image processing.
If you forget to insert a card, or you feed one into the scanner incorrectly, a message box 
will appear to advise you that the scan resulted in an empty page.  Click OK to dismiss the 
window, and click on the Forget command button (or type <Ctrl> + F) to Delete the blank
entry.    Reinsert your card and try again.
When scanning is complete, the card image appears in the Image Window.    The 
Status     Line   now reads:

| None |          Scan 1:1

indicating that the card base has no Key field (None) and that the first card in a card base 
containing one entry has been scanned (1:1).
Notice too that, now that you have a scanned image, Forget , Forget All, Store and Addr 
Edit command buttons are active.    



Multiple Card Scanning 

In addition to single card scanning, BCR lets you scan up to eight cards at a time on flatbed 
type scanners.    While you are still in Scan Mode, switch from single to multiple card 
scanning by selecting Input from the Settings menu (or key in <Alt> + S, then I).  The 
Page Layout window will appear.
Enter the margins of the area or page you want to scan in the Page/Card size boxes and 
check the box at the bottom to select Multiple Cards.    These values can be approximate, 
but should at least include the area occupied by the cards placed.
Place the cards at the proper orientation for your scanner model.    Its important that the 
cards dont touch one another or touch the border of the scan area.    BCR needs to detect a 
brightness difference between adjacent cards so that it can distinguish between them.    If 
they are too tightly grouped, BCR might see them as one large card.    We recommend that 
you place the cards about ¼ apart.    This should give you the best results.
Now begin scanning just as you would for single cards, by clicking on Start     Scan   (or <Ctrl>
+ S).    When the scan is complete, the number of cards successfully scanned will appear in 
the Status     Line   and each card will come up one by one in the Image Window for you to edit
and Store.    If youve scanned eight cards, 1:8 will appear on the right side of the 
Status     Line  .



Image Processing 

After multiple or single card scanning, BCR automatically separates out the cards graphic 
components and converts the remaining image to text.    BCR then divides the text into 
recognizable groupings like phone numbers, company names, etc., surrounds them with text
boxes on the card image and corrects any misalignment resulting from crooked card 
placement.    It then places each text grouping into what it interprets as the appropriate data
field below.
While remarkably accurate for an optical character recognition program, this process is not 
foolproof.    You may have to do some minor editing before storing your entry.
BCR has some convenient features that make editing quick and easy.    You can use the drag
and drop feature (described later in the chapter), or you can simply type the correct 
information into a field.
If you find a card difficult to read because the characters are too small, magnify the card in 
the Image Window by double-clicking on it.    Use scroll-bars to scroll an image.
Another easy way of viewing different parts of a magnified image in Scan     Mode   is to click 
the cursor in a field containing the text you want to see close up.    For example, if the Image
Window shows only the address, and you want to see if the persons name is correct, click 
the cursor in the Title data field.    The card image will shift so that the persons name is 
centered in the Image Window.
To revert to the previous magnification, just double-click on the image.



Editing New Entries 

Redrawing Boxes
Drag-and-Drop Editing
Editing Address Fields
Manual Card Data Input



Redrawing Boxes 

To alter text in a data field, you can redraw the box to surround just the correct text in the 
Image Window.    Press and drag with the left mouse button to draw an area that includes 
only the information you want.
Once you redraw a box, BCR frequently takes the information and drops it into the 
appropriate field without your help.    It does this because your changes make the text more 
recognizable to the program.    Say that the phone and fax numbers appear on the same line 
of a card and BCR has inaccurately grouped the numbers.    If you redraw a box that 
originally included the phone number as well as part of the fax number, both numbers will 
fall into place in the data fields when you correctly redraw one of the boxes.



Drag-and-Drop Editing 
Now use drag-and-drop by clicking and holding the right mouse button on the new box.  
When the hand cursor replaces the pointer, drag the text to the correct data field and 
release the mouse button.
If you attempt to drag a text segment into a field that BCR interprets as incorrect, the cursor 
will assume the form of a circle with a diagonal line through it.    This tells you that youre 
about to drop text in the wrong location.
You can use drag-and-drop to rearrange text boxes on the screen.    To select and drag a 
text box that BCR created automatically, click and hold on the box with the right mouse 
button.    The pointer becomes a hand cursor to let you know that you can now move (copy) 
the box.    The message Move image to desired card field appears in the screens 
Status     Line  .    Now drag the text box to its proper field and release the mouse button to 
drop it in.
Theres no need to line a box up precisely within the data field.    The program will take care 
of text alignment.
As long as youre operating in the Scan Mode and you havent yet stored your scanned 
entry, you can recreate the text boxes on the image, and drag and drop text boxes into the 
fields you choose.    Once the entry has been saved, however, you wont be able to extract 
information directly from the card image.
Except for taking information directly from the card image, you can use all the editing 
operations described here when you go into Edit mode.    The Scan Mode shares yet 
another text tool with the Edit screenThe Edit pull-down options in the programs main 
menu.



Editing Address Fields 

Sometimes BCR incorrectly divides and distributes address information into data fields. 
When this happens you can edit these subfields manually, but, unfortunately, the Drag-
and-Drop technique doesnt help in this case. If you redraw a box around a portion of the 
address, BCR will probably repeat its mistake. As an alternative, you can switch to an 
address editing mode by double-clicking somewhere in the address field (or by clicking the 
Addr Edit button in Scan Mode).    The following data fields appear at the bottom of the 
screen.
BCR shows you an entire address as well as the contents of its four subfields as text strings. 
Now you can highlight desired portions of the whole address or of a subfield (using left 
mouse button). Drag highlighted text (using right mouse button) and drop it in a new 
destination field. The previous contents of that field are replaced. You can also drop portions 
of one address to subfields of the other address. When youve made all necessary changes, 
double-click again on an Address field (or click the Addr Edit button) to revert to the 
standard field template.



Manual Card Data Input 
Suppose you want to enter information about some person, but you do not have business 
card to scan in. What can you    do?
To manually create a new entry in a card base, go into Scan Mode    and click the Type 
Card button. All fields are cleared and the cursor automatically appears in the first field so 
that you can enter the company name. After entering data, advance to the next field by 
pressing <Tab>.
To edit address fields, use the Address Edit mode described earlier in this chapter. When 
youre finished, press Store. Of course, you can freely switch between scanning (Start 
Scan) and manual input (Type Card) since youre in Scan Mode.




